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Apparence de LibreOffice
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ordinateur. En cas de confusion sur une icône, dont l'apparence peut être très différente d'un jeu à 
l'autre, vous pouvez vérifier son nom, qui apparaît dans l'infobulle lorsque vous placez le pointeur 
de la souris au-dessus.
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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et 
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce 
chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage
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Créer des formes simples

Vous pouvez créer des objets 2D et 3D dans Draw. Ce chapitre va vous montrer comment 
dessiner des objets 2D simples. Les chapitres suivants vous indiqueront comment manipuler et 
éditer de tels objets. Pour plus d'informations sur les objets 3D, voir Chapitre 7 (Manipuler des 
objets 3D).

Toutes les formes, qu'elles soient des lignes, des rectangles ou des formes plus complexes, sont 
appelées objets. C'est un terme généralisé pour les applications de dessin vectoriel.

Les outils de dessin se trouvent dans la barre d'outils Dessin (Figure 1).

Figure 1 : Barre d'outils Dessin

Comme indiqué Chapitre 1 (Introduction à Draw), la barre d'outils Dessin se trouve ordinairement 
en bas de la fenêtre. Si vous ne la voyez pas, vous pouvez l'activer à partir de Affichage > Barres
d'outils. Comme avec les autres composants de LibreOffice, vous pouvez détacher la barre 
d'outils Dessin et la placer où vous voulez dans la fenêtre Draw en tant que barre d'outils flottante. 
Vous pouvez également personnaliser la barre d'outils en ajoutant, déplaçant, masquant ou 
supprimant des icônes.

Lorsque vous dessinez une forme, en sélectionnez une pour l'éditer ou ajoutez un texte, la zone 
d'information de la barre d'état (Figure 2) change pour refléter l'action effectuée ou en cours. Voir 
Chapitre 1 (Introduction à Draw) pour plus d'informations sur la barre d'état.

Figure 2 : Barre d'état

Dessiner des formes élémentaires

Les formes élémentaires, dont les textes font partie, sont considérées comme des objets dans 
Draw. Les différents outils disponibles pour dessiner des formes élémentaires sont listés Tableau 
1, de la gauche vers la droite dans la barre d'outils Dessin.

Notez bien que certaines icônes de la barre d'outils Dessin peuvent changer selon la dernière 
forme sélectionnée. Les outils disponibles sont accessibles via le petit triangle noir à droite de 
l'icône. Voir "Dessiner des formes géométriques" page 14 pour plus d'informations sur les formes 
disponibles.
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Tableau 1. Outils de dessin de base

Icône Outil Icône Outil Icône Outil Icône Outil

Sélection-
ner

Ligne Ligne avec 
flèche à la 
fin

Rectangle

Ellipse Texte Courbe Connecteur

Lignes et 
flèches

Formes de 
base

Formes 
des 
symboles

Flèches 
pleines

Organi-
grammes

Légendes Étoiles

Dessiner des lignes droites
L'élément de dessin le plus simple est la ligne droite.

Cliquez sur l'icône Ligne  et placez le curseur de la souris à l'endroit où vous voulez que la 
ligne commence. Faites glisser la souris en gardant son bouton gauche appuyé. Relâchez le 
bouton de la souris à l'endroit où vous voulez que la ligne se termine. Une poignée de sélection 
apparaît à chaque extrémité de la ligne, ce qui indique que cet objet est l'objet sélectionné en 
cours (Figure 3). La poignée de sélection au début de la ligne est légèrement plus grande que 
l'autre.

Figure 3 : Dessiner une 
ligne droite

Si vous maintenez la touche Maj appuyée durant le tracé de la ligne, cela restreint son angle à un 
multiple de 45 degrés (0, 45, 90, 135, etc.).

Attention
Ceci est le comportement par défaut de la touche Maj. Cependant, si l'option Lors de
la création ou du déplacement de l'objet de la section Enclencher de Outils > 
Options > LibreOffice Draw > Grille est cochée, l'action de la touche Maj est 
inversée. Les lignes seront automatiquement tracées avec un angle multiple de 45 
degrés, à moins que la touche Maj ne soit appuyée.

Quand une ligne est dessinée, elle utilise ses attributs par défaut. Pour modifier ces attributs et 
ouvrir la boîte de dialogue Ligne (Figure 4), sélectionnez la ligne en la cliquant, puis faites un clic 

droit et choisissez Ligne dans le menu contextuel, ou cliquez sur l'icône Ligne  de la barre 
d'outils Ligne et remplissage, ou choisissez Format > Ligne dans le menu principal. Le style, la 
largeur et la couleur de la ligne peuvent également être modifiés directement, après avoir 
sélectionné la ligne, en utilisant les zones de la barre d'outils Ligne et remplissage.
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Figure 4 : Boîte de dialogue Ligne

Au cours de votre manipulation de la ligne (ou d'un autre élément), vous pouvez utiliser la zone 
d'information de la barre d'état pour contrôler votre action. Le premier exemple de la Figure 5 vous 
montre la zone d'information au cours du tracé d'une ligne. Le second exemple vous montre cette 
même zone une fois la ligne tracée.
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Figure 5 : Zone d'information de la barre d'état

Dessiner des flèches
Les flèches se tracent de la même façon que les lignes. En fait, Draw répertorie les flèches dans 
un sous-groupe de lignes : les lignes avec une ou des flèches. La zone d'information de la barre 

d'état ne les désigne que comme des lignes. Cliquez sur l'icône Ligne avec flèche à la fin  
pour dessiner une flèche. La flèche est dessinée à la fin de la ligne, à l'endroit où vous relâchez le 
bouton de la souris.

Dessiner différents types de lignes et de flèches
Cliquez sur le petit triangle à droite de l'icône Lignes et flèches de la barre d'outils Dessin pour 
ouvrir une barre d'outils détachable comportant dix outils pour tracer des lignes et des flèches. Le 
dessin de l'icône correspond à l'outil le plus récemment utilisé, ce qui facilite sa réutilisation. Vous 
pouvez également utiliser Affichage > Barres d'outils > Flèches pour ouvrir la barre d'outils 
flottante (Figure 6 et Tableau 2).
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Figure 6 : Barre d'outils Flèches

Tableau 2. Outils de la barre d'outils Flèches

Icône Outil Icône Outil Icône Outil Icône Outil

Ligne Ligne avec 
flèche à la 
fin

Ligne avec 
flèche/ 
cercle

Ligne avec 
flèche/carré

Ligne (45°) Ligne avec 
flèche au 
début

Ligne avec 
cercle/ 
flèche

Ligne avec 
carré/flèche

Ligne de 
cote

Ligne avec 
flèches

Une fois la ligne tracée, vous pouvez encore modifier le style de flèche en cliquant sur l'icône Style

de flèche  de la barre d'outils Ligne et remplissage et en choisissant un style de flèche pour le 
début ou la fin de la ligne. Vous pouvez également le faire dans les onglets Ligne et Styles de 
flèches de la boîte de dialogue Ligne. Voir Chapitre 4 (Modifier les attributs d'un objet) pour plus 
d'informations.

Dessiner des rectangles ou des carrés

Dessiner un rectangle est similaire à dessiner une ligne droite. Cliquez sur l'icône Rectangle  
de la barre d'outils Dessin. Au fur et à mesure que vous faites glisser la souris, le rectangle se 
dessine jusqu'à la position du curseur.

Les carrés sont des rectangles dont les côtés sont de même longueur. Pour dessiner un carré, 

cliquez sur l'icône Rectangle  et gardez appuyée la touche Maj pendant que vous faites glisser
la souris.

Attention
Ceci est le comportement par défaut de la touche Maj. Cependant, si l'option Lors de
la création ou du déplacement de l'objet de la section Enclencher de Outils > 
Options > LibreOffice Draw > Grille est cochée, l'action de la touche Maj est 
inversée. Des carrés seront tracés, à moins que la touche Maj ne soit appuyée pour 
dessiner des rectangles.

Pour dessiner un rectangle ou un carré à partir de son centre, positionnez le curseur dans votre 
document, cliquez sur le bouton de la souris et gardez appuyée la touche Alt pendant que vous 
faites glisser le curseur. Le rectangle ou le carré utilisera la position de départ (l'endroit où vous 
avez cliqué en premier sur le bouton de la souris), comme centre.

Une fois un rectangle ou un carré sélectionné, vous pouvez modifier rapidement le style, la largeur 
et la couleur de la bordure, ainsi que le type et la couleur de remplissage, en utilisant les outils de 
la barre d'outils Ligne et remplissage. Vous pouvez également utiliser les commandes du menu 
contextuel (après un clic droit) ou du menu Format. Voir Chapitre 4 (Modifier les attributs d'un 
objet) pour plus d'informations.
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Dessiner des ellipses ou des cercles

Pour dessiner une ellipse (un ovale), cliquez sur l'icône Ellipse  de la barre d'outils Dessin. Au 
fur et à mesure que vous faites glisser la souris, l'ellipse se dessine à l'intérieur du rectangle allant 
jusqu'à la position du curseur.

Les cercles sont des ellipses dont les axes sont de même longueur. Pour dessiner un cercle, 

cliquez sur l'icône Ellipse  et gardez appuyée la touche Maj pendant que vous faites glisser  la 
souris.

Attention
Ceci est le comportement par défaut de la touche Maj. Cependant, si l'option Lors de
la création ou du déplacement de l'objet de la section Enclencher de Outils > 
Options > LibreOffice Draw > Grille est cochée, l'action de la touche Maj est 
inversée. Des cercles seront tracés, à moins que la touche Maj ne soit appuyée pour 
dessiner des ellipses.

Pour dessiner une ellipse ou un cercle à partir de son centre, positionnez le curseur dans votre 
document, cliquez sur le bouton de la souris et gardez appuyée la touche Alt pendant que vous 
faites glisser le curseur. L'ellipse ou le cercle utilisera la position de départ (l'endroit où vous avez 
cliqué en premier sur le bouton de la souris), comme centre.

Une fois une ellipse ou un cercle sélectionné, vous pouvez modifier rapidement le style, la largeur 
et la couleur de la bordure, ainsi que le type et la couleur de remplissage, en utilisant les outils de 
la barre d'outils Ligne et remplissage. Vous pouvez également utiliser les commandes du menu 
contextuel (après un clic droit) ou du menu Format. Voir Chapitre 4 (Modifier les attributs d'un 
objet) pour plus d'informations.

Note
Si vous cliquez sur l'icône Ligne, Rectangle, Ellipse ou Texte en gardant appuyée 
la touche Ctrl, un objet correspondant est automatiquement dessiné au centre de 
l'espace de travail en utilisant les valeurs par défaut.
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Dessiner des arcs ou des segments
Si vous voulez dessiner des arcs ou des segments (des ellipses ou cercles partiels), vous devez 
tout d'abord faire apparaître la barre d'outils Cercles et ellipses. Cette barre d'outils n'étant par 
défaut pas accessible depuis la barre d'outils Dessin, allez à Affichage > Barres d'outils.

Figure 7 : Barres d'outils 
Cercles et ellipses

Tableau 3. Outils de la barre d'outils Cercles et ellipses

Icône Outil Icône Outil Icône Outil Icône Outil

Ellipse Cercle Secteur 
d'ellipse

Secteur de 
cercle

Segment 
d'ellipse

Segment 
de cercle

Ellipse, non
remplie

Cercle, non
rempli

Secteur 
d'ellipse, 
non rempli

Secteur de 
cercle, non 
rempli

Segment 
d'ellipse, 
non rempli

Segment 
de cercle, 
non rempli

Arc 
d'ellipse

Arc de 
cercle

Pour dessiner des arcs et des segments :

1) Sélectionnez l'icône voulue dans la barre d'outils Cercles et ellipses. Le curseur de la 
souris se transforme en croix avec un segment de cercle.

2) Cliquez et faites glisser le curseur de la souris pour créer une ellipse ou un cercle de 
guidage, puis relâchez le bouton de la souris. Vous obtenez un dessin à l'écran similaire à 
celui ci-dessous.

3) Déplacez le curseur de la souris à l'endroit où vous voulez que l'arc ou le segment 
commence. La barre d'état vous indique l'angle en degrés. Faites un simple clic à cet 
endroit. Vous obtenez un dessin à l'écran similaire à celui ci-dessous.

4) Déplacez le curseur de la souris à l'endroit où vous voulez que l'arc ou le segment se 
termine. La barre d'état vous indique l'angle en degrés. Faites un simple clic à cet endroit 
pour terminer l'arc ou le segment.

Dessiner des courbes et des polygones

Pour dessiner une courbe ou un polygone, cliquez sur l'icône Courbe  de la barre d'outils 
Dessin. Cliquez sur le petit triangle à droite de l'icône pour accéder aux outils disponibles (Figure 8
et Tableau 4).

Dessiner des formes élémentaires 11



Note
Si vous placez le curseur de la souris au-dessus de l'icône, l'infobulle vous indique le
terme Courbe. Si vous détachez la barre d'outils, le titre est Lignes (Figure 8).

Figure 8 : Barre d'outils Lignes 
(Courbe)

Tableau 4. Outils de la barre d'outils Lignes (Courbe)

Icône Outil Icône Outil Icône Outil Icône Outil

Courbe, 
remplie

Polygone, 
rempli

Polygone 
(45°), 
rempli

Ligne à 
main levée,
remplie

Courbe Polygone Polygone 
(45°)

Ligne à 
main levée

Courbes
Cliquez et gardez appuyé le bouton gauche de la souris pour créer le point de départ de la courbe.
Puis, tout en gardant le bouton de la souris appuyé, faites glisser le curseur pour tracer une ligne 
droite à partir de ce point de départ. Relâchez le bouton gauche de la souris et déplacez le curseur
pour infléchir la ligne droite en une courbe. Cliquez pour fixer la courbe dans la page. Vous pouvez
continuer votre ligne en déplaçant le curseur de la souris et en cliquant pour fixer le point d'angle 
suivant ; vous pouvez infléchir la ligne obtenue en gardant le bouton gauche de la souris appuyé et
en le faisant glisser jusqu'à obtenir ce que vous désirez. Pour terminer la courbe, double-cliquez.

Une courbe remplie joint automatiquement le dernier point de la courbe avec son point de départ, 
pour la refermer et la remplir avec la couleur standard. Une courbe non remplie n'est pas refermée
à la fin du tracé.

Polygones
Cliquez et gardez appuyé le bouton gauche de la souris pour créer le point de départ du polygone. 
Puis, tout en gardant le bouton de la souris appuyé, faites glisser le curseur pour tracer la première
ligne. Déplacez le curseur pour dessiner la ligne suivante. Chaque clic de souris va déterminer un 
point d'angle et vous permet de dessiner une autre ligne. Double-cliquez pour terminer le 
polygone.

Un polygone rempli joint automatiquement le dernier point d'angle avec son point de départ, pour 
le refermer et le remplir avec la couleur standard. Un polygone non rempli n'est pas refermé à la 
fin du tracé.

Polygones à 45°
Les polygones à 45° se tracent comme les autres polygones, mais les angles entre les lignes sont 
limités aux multiples de 45 degrés. Par contre, si le polygone à 45° est fermé, la ligne tracée 
automatiquement pour refermer la figure peut former des angles non multiples de 45 degrés.

Note
Si vous gardez appuyée la touche Maj durant le tracé d'une courbe ou d'un 
polygone, les angles seront limités aux multiples de 45 degrés.
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Lignes à main levée
L'utilisation de l'outil Ligne à main levée est similaire au dessin sur un papier avec un crayon. 
Cliquez et gardez appuyé le bouton gauche de la souris, et faites glisser le curseur pour dessiner 
la ligne que vous voulez. Pour terminer la ligne, relâchez simplement le bouton : il n'est pas 
nécessaire de double-cliquer.

Une ligne à main levée remplie est automatiquement complétée par une ligne droite entre le point 
d'arrivée et le point de départ, et l'objet est rempli avec la couleur standard.

Points de collage et connecteurs

Points de collage
Tous les objets Draw ont des points de collage, qui ordinairement ne sont pas affichés. Les points 
de collage deviennent visibles quand l'icône Connecteur est sélectionnée.

Figure 9 : Points 
de collage

La plupart des objets ont quatre points de collage (Figure 9). Vous pouvez ajouter et personnaliser 
des points de collage avec la barre d'outils Points de collage (Figure 10). Allez à Affichage > 
Barres d'outils > Points de collage pour la faire apparaître.

Figure 10 : Barre d'outils Points de collage

Les points de collage ne sont pas les poignées de sélection d'un objet. Les poignées de sélection 
servent à modifier la forme d'un objet, comme décrit Chapitre 3 (Manipuler les objets et les points 
des objets). Les points de collage servent à relier un connecteur à un objet afin que, quand l'objet 
se déplace, le connecteur reste relié. Pour plus d'information sur les points de collage, voir 
Chapitre 8 (Connections et organigrammes).

Connecteurs
Les connecteurs sont des lignes ou des flèches dont les extrémités sont fixées à un point de 
collage d'un objet. Ils sont très utiles pour dessiner des organigrammes, des diagrammes de flux et
des cartes heuristiques. Lorsque les objets sont déplacés ou réordonnés, les connecteurs restent 
fixés à un point de collage. La Figure 11 montre l'exemple de deux objets reliés par un connecteur.
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Figure 11 : Deux objets reliés par un 
connecteur

Draw dispose de plusieurs connecteurs et fonctions de connexion. Cliquez sur le petit triangle à 
droite de l'icône Connecteur pour ouvrir la barre d'outils Connecteurs. Pour une description plus 
détaillée de l'utilisation des connecteurs, voir Chapitre 8 (Connections et organigrammes).

Figure 12 : Barre d'outils Connecteurs

Tableau 5. Outils de la barre d'outils Connecteurs

Icône Outil Icône Outil Icône Outil Icône Outil

Connecteur Connecteur
avec flèche
à la fin

Connecteur
avec 
flèches

Connecteur
linéaire

Connecteur
linéaire 
avec flèche
à la fin

Connecteur
linéaire 
avec 
flèches

Connecteur
direct

Connecteur
direct avec 
flèche à la 
fin

Connecteur
direct avec 
flèches

Connecteur
incurvé

Connecteur
incurvé 
avec flèche
à la fin

Connecteur
incurvé 
avec 
flèches

Dessiner des formes géométriques

Les icônes pour dessiner des formes géométriques se situent dans la barre d'outils Dessin. 
Cliquez sur le petit triangle à droite de chaque icône pour ouvrir la palette d'outils correspondante.

L'utilisation des outils pour dessiner des formes géométriques est similaire à celle de l'outil pour 
dessiner des rectangles et des carrés. Voir "Dessiner des rectangles ou des carrés" page 9.

Note
Les icônes pour les formes géométriques dans la barre d'outils Dessin sont variables
et changent selon le dernier outil sélectionné et utilisé pour dessiner un objet.
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Formes de base
Cliquez sur le petit triangle à droite de l'icône Formes de base pour ouvrir la barre d'outils Formes 
de base (Figure 13). Cette barre d'outils comprend des outils Rectangle et Ellipse identiques à 
ceux qui se trouvent dans la barre d'outil Dessin.

Figure 13 : Barre d'outils Formes de base

Formes des symboles
Cliquez sur le petit triangle à droite de l'icône Formes des symboles pour ouvrir la barre d'outils 
Formes des symboles (Figure 14).

Figure 14 : Barre d'outils Formes des symboles

Flèches pleines
Cliquez sur le petit triangle à droite de l'icône Flèches pleines pour ouvrir la barre d'outils Flèches 
pleines (Figure 15).

Figure 15 : Barre d'outils Flèches pleines

Organigrammes
Cliquez sur le petit triangle à droite de l'icône Organigrammes pour ouvrir la barre d'outils 
Organigramme (Figure 16). La création des organigrammes, diagrammes de flux et autres outils 
similaires est détaillée Chapitre 8 (Connections et organigrammes).

Figure 16 : Barre d'outils Organigramme
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Légendes
Cliquez sur le petit triangle à droite de l'icône Légendes pour ouvrir la barre d'outils Légendes 
(Figure 17).

Figure 17 : Barre d'outils 
Légendes

Étoiles
Cliquez sur le petit triangle à droite de l'icône Étoiles pour ouvrir la barre d'outils Étoiles et 
bannières (Figure 18).

Figure 18 : Barre d'outils Étoiles et bannières

Dessiner successivement plusieurs formes

Vous pouvez dessiner successivement plusieurs formes, plusieurs lignes par exemple, sans avoir 
à sélectionner l'icône Ligne à chaque fois. Pour ceci, double-cliquez sur l'icône de la forme que 
vous souhaitez dessiner. Tracez votre première forme. Vous pouvez remarquer que le pointeur de 
la souris garde la même apparence et ne revient pas au symbole qu'il a lorsqu'il est un outil de 
sélection. Tracez les formes suivantes. Pour terminer, appuyez sur la touche Échap ou faites un 
clic simple dans le dessin.

Vous pouvez faire de même avec les formes géométriques. Par contre, il est nécessaire de 
détacher la barre d'outils correspondante avant de double-cliquer sur la forme désirée.

Ajouter du texte aux dessins et aux objets

Dans Draw, vous pouvez ajouter, insérer et formater du texte dans un document, dans des objets 
ou dans des formes de plusieurs façons.

Vous pouvez gérer des textes avec cadre dynamique, qui sont des objets Draw indépendants que 
vous pouvez placer où vous voulez dans votre document et dont le cadre s'étend au fur et à 
mesure que vous ajoutez du texte.

Vous pouvez également insérer un texte dans un objet préalablement dessiné. Ce texte est intégré
à l'objet et est placé dans un rectangle inscrit à l'intérieur des limites qui entourent l'objet. Ce 
rectangle n'est pas dynamique et vous devez faire attention à ce que votre texte ne déborde pas 
des limites de l'objet.

Pour plus d'informations, voir Chapitre 9 (Ajouter et formater un texte).
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